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Abstract 
Before its mass-mortality in the 1980’s, Diadema antillarum was the most important benthic herbivore 
on Caribbean reefs. Since then, reefs have experienced an increase in turf/macroalgae abundance. 
Despite the approximate 40 years that have past, natural recovery is slow and variable. Therefore 
efforts are taken to boost D. antillarum recovery artificially. Several bottlenecks for recovery have been 
found, but in the last decade a new potential problem has risen: massive influxes of floating Sargassum 
species. Studies have shown that algae or its biofilm can induce sea urchin settlement to a certain 
extent, but no in vivo experiments have been conducted for D. antillarum. Here we investigated if 
these Sargassum floats interfere with the recruitment of D. antillarum by measuring the abundance of 
D. antillarum settlers in submerged and floating, rinsed and unrinsed Sargassum units and comparing 
values with a positive control. While the amount of data collected with the low sample sizes did not 
suffice to answer the research question in any statistically significant manner, hypothesis could be 
formulated.   

D. antillarum certainly is attracted to sargassum patches, whether as post-settler only or also 
as settler is however still debatable. Cues by conspecifics could possibly play a role in increased 
settlement in Sargassum, blurring the effect of Sargassum solely. A large variation in D. antillarum 
abundance was found for the unrinsed submerged treatment, which was possibly the result of 
migration from nearby existing ecosystems with older D. antillarum into the experimental units, or it 
was an artefact of the low sample size. To confidently distinguish signal from noise in a similar study, 
some alterations to the research design need to be made and drifting sargassum patches need to be 
sampled to get a sense of D. antillarum settler abundance on naturally occurring Sargassum. 

  



Introduction 

1.1 Problem description  
The long-spined sea urchin species D. antillarum was the most important benthic herbivore on 

Caribbean reefs until 1983, when it suffered mass mortality of on average 98% by a Caribbean wide 

pathogen (Lessios et al., 2001). Post-mortality scarcity resulted in increased turf/macro-algae 

abundance. This condition in turn decreased coral reef cover since algae compete for space with 

juvenile corals (Mubmy et al., 2007). D. antillarum recovery is key to reducing macroalgal cover and 

increasing abundance of juvenile corals on Caribbean reefs (Edmunds & Carpenter, 2001). In the past 

couple of decades some natural recovery of D. antillarum has been observed but this has been slow 

and variable (Alice Rogers & Lorenzen, 2016). 

Recent efforts to increase D.antillarum abundance focus on increasing local abundance artificially by 

either raising them in laboratory settings and subsequently seeding them on reefs (Williams, 2016), or 

by creating favorable conditions for larvae settlement with artificial reef structures (Hylkema et al., 

2020), executed on Saba and St. Eustatius. While these and similar restocking practices already have 

the potential to relieve the species from some hurdles for recovery, identifying more reasons for their 

natural absence can aid in finding solutions for assisted recovery. Bottlenecks for recovery exist in 

various life stages of the sea urchin, such as in larval supply as a result of too few adults, (Lessios, 2005), 

in settlement and post‐settlement survival due to a lack of suitable locations and high predation 

pressure (Rogers & Lorenzen, 2008), or even pathogens remaining in water (Lessios, 2005). 

In the last decade, a new potential problem adds to the causes of the slow recruitment of the sea 

urchins on reefs in the Caribbean: the occurrence of drifting Sargassum floats. While occurrence of 

these floats, otherwise known as ‘golden tides’, along coastlines is common for most Caribbean island 

nations (Louime, Fortune & Gervais, 2017), during the last decade the occurrence of these mats along 

Caribbean coastlines has increased and concerns regarding their environmental and economic impact 

have risen (Putman et al., 2018; van Tussenbroek et al., 2017; Wang & Hu, 2017). Once these golden 

tides wash ashore, they decompose into murky ‘Sargassum brown tides’. Besides the obvious 

economic impact that beached decaying Sargassum floats have via the appeal for tourism (Putman et 

al., 2018), the effects extend to reduction in light, oxygen and pH which ultimately result in changes in 

community structure and the decrease of healthy coastal habitats (Cabanillas-Teran et al., 2019; van 

Tussenbroek et al., 2017). D. antillarum herbivory specifically was found to be negatively impacted by 

these Sargassum blooms through organic matter inputs coupled with hypoxia that lead to detrimental 

modification of natural algal resources (Cabanillas-Teran et al., 2019). However, the effect of 

Sargassum floats on recruitment of D. antillarum has not been investigated to date. Seasonal 

occurrence of these floats throughout the Caribbean is variable, but the greatest influx of these floats 

for the leeward islands tends to happen from spring, through summer and into the fall months (Hinds 

et al., 2016), with a peak in summer (Brooks et al., 2018). The reproductive periodicity of D. antillarum 

largely coincides with this peak in Sargassum influx. With the recent increase in abundance of 

Sargassum floats, the question arises if D. antillarum larvae are increasingly attracted to chemical cues 

from these floats instead of reef structures and that their final fate might then be to be beached and 

die, never to be contributing to the recovery of D. antillarum populations.  

Reason to think this phenomena might be happening are results of investigation into settlement cues 

for echinoderm larvae. Cues hypothesized to induce settlement of larvae are biochemicals from adult 

populations (Hunte and Younglao, 1988). Others suggested that D. antillarum is attracted to cues that 

arise from nutrients or algae (Alice Rogers & Lorenzen, 2016). For the urchin species S. droebachiensis 

and S. purpuratus macro-algae were found to have no effect on metamorphosis but instead the 
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bacteria on the algae were found to have a positive effect (Pearce & Scheibling, 1991; Dworjanyn & 

Pirozzi, 2008). Similarly, for the species P. lividus a positive effect of macro-algae was found but it could 

not be excluded that this effect was due to the biofilm on the algae (Castilla-Gavilán et al., 2018; Rial 

et al., 2018). Bak (1985) concluded that for D. antillarum the absence of turf- and macro-algae was 

important for settlement, but found that they preferred to not settle on freshly placed and clean panels 

indicating a preference for slightly older biofilm coated panels. While the exact source for the 

settlement cues is debatable, laboratory experiments with a handful of algae substrates hinted that 

Sargassum fluitans, or its biofilm, had settlement inducing properties for D. antillarum (van Nimwegen, 

2021). Not surprisingly though, as in the open ocean this algae functions as a suitable spawning and 

nursery area or habitat for numerous invertebrates, fish, turtles and birds (van Tussenbroek et al., 

2017; Laffoley et al., 2011). Contrary to this finding Thabard et al. (2011) found that extracted 

molecules produced  both  by  the  alga Sargassum polyceratium and its associated biofilm, inhibited 

D. antillarum metamorphosis from a concentration of 5 µg/ml onward. 

While laboratory studies might indicate the settlement inducing capacity of Sargassum spp. or even 

the opposite, the question whether floating Sargassum rafts actually affect settlement of D. antillarum 

in situ, remains unanswered. For that phenomena to happen, D. antillarum larvae and Sargassum 

floats need to meet. The free floating, larval stage of the sea urchin allows for their occurrence at 

varying water depths. Williams et al. (2011) found an optimal settlement depth for this species at 9 

meter, and lower settlement at the shallower locations. While most Sargassum drifts at the surface, 

wind action can force the floats to sink (Johnson & Richardson, 1977). Settlement densities on 

Sargassum can therefore be hypothesized to vary for different depths. Here we investigate to what 

extend the phenomena of settlement on Sargassum patches might be happening at two different 

depths and discuss if it is on a scale that might have an impact on D. antillarum recruitment. 

Additionally, a pilot investigation into the species composition of drifting Sargassum patches showed 

a prominent amount of D. antillarum predators in samples taken. Because this could influence survival 

of young settlers the possible effect is accounted for in the research design. If D. antillarum are found 

to be attracted to the Sargassum floats in obvious abundances, this can add to the explanation of their 

limited recovery rates. 

1.2 Research questions  
The forenamed issue can be divided into the following research question and sub questions. 

To what extend do D. antillarum settle on Sargassum and is there an influence of location in 

the water column on settlement? 

- What is the density of D. antillarum settlement on Sargassum at the surface and 
on submerged Sargassum? 

- Is potential predation on D. antillarum settlers of influence on post settlement 

survival in naturally occurring Sargassum?  

1. Methods 

2.1 Research location and timeframe 
The experiment was executed along the Caribbean island of Saba. Previous investigations into D. 
antillarum settlement densities around Saba in 2020 by Mareike de Bruyn and Alwin Hylkema revealed 
that settlement densities were highest on the west side of the island at the locations named ‘Ladder 
bay’ and ‘Torrents point’ (Fig. 1). Ladder bay features a flat sandy area between patchy reefs which 
facilitates the placement of an experimental setup. Previous data of 2020 showed that settlement on 
Saba starts in April and continues until November and no settlement had been observed from 
December till March. The optimum conditions for settlement of D. antillarum on Saba were in May 



and June. While deployment of the experiment earlier in the year is thus advisable, the experiment 
was deployed at Ladder Bay from the 29th of July till the 24th of August 2021. 
 

 

Figure 1: The location at Ladder bay with repeats of the experiment. Each repeat in turn has a set-up as indicated in figure 3. 
The set-up furthermore follows the design as depicted in appendix II, figure 3. 

To answer the question of differential settlement density as a function of depth and simultaneously 
figure if there is an effect of present predators, a 2x3 research design has been used. Three different 
treatments at two depths with four replicates each amounted to 24 experimental units. The first 
treatment is a positive control group to compare settlement densities with. The control group consists 
of frames filled with strings with so-called bio balls, balls that whose surface area is optimized to 
facilitate maximum biofilm formation for fish ponds and aquaculture and which have shown to 
function as useful echinoderm settler collectors (Balsalobre et al., 2016). Each unit in this treatment 
consists of a 25 x 25 cm (2 inch diameter) PVC frame filled with 2 strings of 65 bioballs each, creating 
a surface area of approximately 0.85 m2 per unit. This surface area for an experimental unit was 
decided upon because the corresponding volume of Sargassum could consistently be taken from a 
drifting patch with a 24 inch sieve. The area of a volume was measured using Fiji (imageJ) version 2.1.0 
according to “Protocol for area measurement using (Fiji)ImageJ v2.1.0” (Appendix 0). The second and 
third treatment had identical frames filled with an equivalent of respectively rinsed and unrinsed 
Sargassum taken from a big drifting patch “Protocol collection Sargassum, deployment of experiment 
and processing” (Appendix I). 
 



 

Figure 2: view of respectively the bioballs and Sargassum in an experimental unit. The sample with the bioballs in the figure 
is one at 7 meters below the surface while the Sargassum sample is one at the surface.   

 

Experimental units were hung at the surface and at a depth of 7 meter (± 0.5 m) at the dedicated 

location at ladder bay. Treatment and secondary treatment by location in the water column resulted 

in 6 different partitions (Table 1).  

Treatment name Treatment ID 
Bioballs at surface   Bio_Opp  4  replicates: (1_1 | 1_2 | 2_1| 2_2) 
Bioballs subsurface  Bio_Sub                                 ‘’ 
Rinsed Sargassum at surface  Rins_Opp                              ‘’ 
Rinsed Sargassum subsurface  Rins_Sub                               ‘’ 
Unrinsed Sargassum at surface  Unrins_Opp                          ‘’ 
Unrinsed Sargassum subsurface  unrins_Sub                           ‘’ 

 

Each of these 6 secondary treatments received 

2 spots to hang the replicates according to 

figure 3. At each of 6 spots two ropes are 

anchored to the same anchor point, usually 

interlinked concrete blocks. Each rope received 

2 replicates of a treatment. The surface rope 

has 2 of the 4 replicates of a surface treatment 

and the subsurface rope received 2 of the 4 

replicates of a subsurface treatment. The 

remaining four replicates of these two 

secondary treatments would then be hung at a 

second spot. Similarly, the two other 

treatments got two dedicated spots each.   

 

 

 

 

Figure 3: Six spots along ladder bay will have the 
set up as depicted. Per treatment (rinsed/un-
rinsed/Bioballs), two spots were occupied. Per 
spot, two frames were hung at a surface line, 
spaced 1 meter apart, and two were hung at a 
sub-surface rope approximately 7 meters depth, 
spaced 1 meter apart. 



2.3 Deployment , data collection & analysis 
Apart from one rope all sub-surface ropes had been in the water for some time and D. antillarum had 
already migrated on the ropes. Therefor ropes were inspected before deployment and D. antillarum 
were translocated to nearby reefs before experimental units were placed. Surface ropes were not 
inspected because they had not been in the water for longer than 5 days. On the deployment date a 
Sargassum patch was visited and a volume sufficient to fill 26 PVC frames was put in a cooler. 16 
volumes were used for the experiment and 10 volumes were taken and searched for inhabiting species 
according to “Protocol collection Sargassum, deployment of experiment and processing” (Appendix I). 
Three Sargassum types are commonly found in the region and for 4 of the 10  volumes the length of 
these different species and types of most common Sargassum were measured (Appendix I), to figure 
species ratios of Sargassum used in the experiment.  After the four week duration of the experiment, 
experimental units were taken on land and searched for D. antillarum and other inhabiting species 
according to “Protocol analysis D. antillarum settlement Sargassum” (Appendix II). D. antillarum were 
collected and photographed for length measurements with Fiji (ImageJ) version 2.1.0 following “D. 
antillarum measurement protocol ImageJ v1.0”.  
Length and count data of D. antillarum 

were analyzed and visualized using R, 

RStudio version 4.0.4. Data from a study 

on D. antillarum settlement on Bioballs 

earlier in 2021, was used to filter 

between settlers and older D. 

antillarum (van de Pas, 2021). There 

freshly placed bioball streamers are 

hypothesized to mainly attract settlers 

as older D. antillarum are prevented 

from climbing the thin fishing line that 

attaches the streamers to reefs. In the 

calculation of the mean, data for both 

monitoring months were pooled 

because a similar density pattern could 

be recognized (Fig. 4) and settler length is assumed to have one mean length over this period. Because 

of the left skew of that data, length values were natural log-transformed before a mean and standard 

deviation were computed. The back-transformed mean and standard deviation were used in the 

computation of the left bound of settler length: 𝑒𝑥𝑝(𝑚𝑒𝑎𝑛 𝑜𝑓 𝑙𝑜𝑔 − 𝑡𝑟𝑎𝑛𝑠𝑓𝑜𝑟𝑚𝑒𝑑 𝑙𝑒𝑛𝑔𝑡ℎ +

 (𝑠𝑑 𝑜𝑓 𝑙𝑜𝑔𝑡𝑟𝑎𝑛𝑠𝑓𝑜𝑟𝑚𝑒𝑑 𝑙𝑒𝑛𝑔𝑡ℎ ∗ 2)) ~ 1.7.  D. antillarum longer than this length were classified as post-

settler D. antillarum in the analysis. 

Filtered data was then analysed using two non-parametric kruskall wallis tests for overall treatment 

differences. The formula compare_means(method=”Kruskal”) was applied to the submerged 

treatments and treatments at the surface. This was followed by a within treatment Wilcoxon-Mann-

Whitney-U  ranked sum test using the formula Wilcoxon.test( paired=F ). However, because of the 

limited amount of D. antillarum found to underpin statistical analyses, hypothesis were formulated 

about the occurrences in the different treatments.  

  

Figure 4: Histogram of D. antillarum counts per length of data from May (dark grey) 
and June (light grey) in 2021, with pooled mean (black dashed line) and 2*standard 
deviation (grey dashed lines). 



3. Results 

3.1 Sargassum type ratios and inhabiting species 
For deployment of the experiment a 

Sargassum patch was visited and 10 

volumes were kept behind for sampling 

after deployment. In these samples a total 

of 3 regular crabs, 13 regular shrimp and 3 

fireworms were found. No D. antillarum 

were found in these samples. While the 

protocol asked for directly putting samples 

in separate bags, this was forgotten and 

samples were taken from left over 

Sargassum in the coolbox after deployment 

of the experiment. This way, possible 

inhabiting species could have redistributed 

themselves to cooler areas in the cooler and 

could have escaped the Sargassum.  

Stalk length measurements were used as a 

proxy for relative surface area of the 

Sargassum in a sample. S. fluitans III 

revealed to be most abundant in the patch, 

accounting for up to 70 percent of the total 

stalk length in the samples (Fig.5). S. natans 

VIII was least abundant. It has however to be 

noted that leaf count and area differs 

considerably between the different 

Sargassum species and types and that 

length is a mere approximation for their 

ratios within a sample.    

No obvious amount of inhabiting 

creatures was found in the samples at 

time of deployment. However after the 

experiment, samples were searched for 

inhabitants again and much more 

creatures were encountered. Especially 

the amount of shrimp other than 

praying mantis shrimp was high: 232 

divided over the  24 samples. Most 

(~50%) of these shrimps were found in 

the unrinsed Sargassum, while rinsed 

Sargassum as well as the bioball 

treatment both had around 25 % of the 

total amount of shrimp in them. Four unrinsed Sargassum units, 2 at the surface at separate locations 

and 2 sub-surface, also from a separate location each, had an average of 24.75 shrimps in them. This 

in contrast to the rinsed Sargassum units, which had on average less than 10 shrimps in them, both 

sub-surface and at the surface, similar to the amount found in the bioball units that had no species on 

Figure 5: The three most common pelagic Sargassum morphotypes encountered 
around Saba: S. natans I, S. natans VIII, and S. fluitans III and their ratios in 
samples at time of deployment. Figure adapted from Govindarajan et al., (2019). 

Figure 6: Barplots of mean settler density per treatment and secondary treatment, with 
standard error for the mean. 



them to begin with (Fig. 6) This obvious difference, however not significant, indicates that rinsing the 

Sargassum changes the abundance of creatures entering the experiment. Rinsing thus seems to be a 

viable method to have inhabitant presence mainly consist of influx by new creatures.  

3.2 D. antillarum count and length distribution  
During the 26 day experiment a total of 71 D. antillarum were found (one photo for length analysis 

was missing and length could not be computed for this D. antillarum). Length ranges and found 

amounts of D. antillarum were quite variable per treatment. Most D. antillarum were found in the 

unrinsed submerged Sargassum and biggest size ranges were found in the unrinsed Sargassum 

treatment (Table 1).  

Table 1: Sizes, size ranges (both in mm) and amount of found D. antillarum per treatment. Of the D. antillarum found per 
treatment a certain amount can be classified as settler. The cut-off length for being classified as a settler is 1.67 mm. 

  

 

Figure 7: D. antillarum counts per length and treatment. Grey bars in background reflect the densities in the settlement in the 
bioballs experiment from June (darkgrey) and July (lightgrey). Counts for these months are high because more experimental 
units were searched for D. antillarum. Mean length for cumulative counts for these months is indicated with black dotted line 
and the grey dotted lines indicate the distance of 2* standard deviation away from the mean. D. antillarum with a length 
below the upper boundary of that range classify as settlers in our experment.  

Treatment Min 
(mm) 

Max 
(mm) 

Range 
width 

Total D. 
antillarum 

count 

Total 
settler 
count 

Mean settlement 
density  

(m-2) 
Bio_Opp 0.764 0.864 0.100 2 2 0.58 
Bio_Sub 0.525 3.355 2.830 9 8 2.32 
Rins_Opp 2.232 3.918 1.686 2 0 0.00 
Rins_Sub 2.341 3.659 1.318 6 0 0.00 
Unrins_Opp 1.401 5.714 4.313 5 1 0.30 
Unrins_Sub 0.905 4.629 3.724 46 11 3.60 



On the basis of settlement 

counts on bioballs from June and 

July earlier in the year, a cut of 

value for classifying as a settler of 

approximately 1.7 mm was 

constructed. Although these 

bioballs were hanging at a 

different depth, had only 30 balls 

per string (with a total surface 

area of 0.2 m2) and hang earlier 

in the year, this data gives a clear 

indication of the length 

distribution of settlers over a 

four week period. These bioballs 

also hung in the water for a 

month and are assumed to 

foremost attract settlers. Most D. 

antillarum settlers were found in July during that experiment. Here, when extrapolating to a surface 

area of 1 squared meter, a mean settlement density of 41.1 m-2 was found in June and a mean 

settlement density of 143 m-2 was found in July. These amounts are contrasting the current study 

where on the bioballs at the surface a mean density of 0.58 m-2 was found and on the submerged 

bioballs a mean density of 2.32 m-2 was found (Table 1, Fig. 8). The bioball treatments had the highest 

relative amount of settlers on them compared to the overall D. antillarum count, followed by the 

unrinsed treatment (Table 1, Fig. 7). Highest absolute settler densities were found in the unrinsed 

submerged treatment. However, of the total D. antillarum found in the Sargassum treatments, only 

20 % could be classified as actual settlers. This percentage is furthermore mainly driven by one 

observation in which 27 D. antillarum were found of which 10 D. antillarum were settlers, accounting 

for 17% of the settlers found in Sargassum treatments. The rinsed Sargassum treatment did not attract 

settlers.  

When simply looking at occurrences of the different classifications of the life-stages for the different 

treatments we find the following. The bioballs mainly attracted settlers, 2 at the surface 8 sub-surface, 

and 1 D. antillarum supposedly migrated into the experimental unit. In the rinsed Sargassum only post-

settlement D. antillarum were found, 2 were found in the same surface unit, and 6 were found in 3 

sub-surface units which each had 2 of these D. antillarum. In 11 of the 16 experimental units D. 

antillarum were found. In only 4 of these 11 units D. antillarum could be classified as settlers.  

In the unrinsed Sargassum a total of 13 settlers was found. 10 of these were found in a submerged 

unit that had 27 D. antillarum in total in them. 1 settler was found in a surface unit together with a 

post-settler and the other 2 settlers were found in submerged units with 9 and no post-settlement D. 

antillarum respecitvely. The remaining submerged experimental unit also had a relatively high amount 

of post-settlement D. antillarum (9), but no settlers. The rinsed Sargassum treatment did not have 

settlers but did have 3 experimental units with 2 post-settlement D. antillarum per unit each.  

The big amount of D. antillarum found in that one submerged unit with 27 urchins coincides with the 

high amount of shrimp. However, this was not necessarily the case for other units were many shrimp 

were found. Overall, no correlation between the amount of predators and the D. antillarum counts 

has been found. Finally, kruskall wallis rank sum tests between treatments revealed that no significant 

difference in medians could be detected between sub-surface treatments as well as between surface 

Figure 8: Bar plot of mean settler density per treatment and secondary 
treatment, with standard error for the mean. 



treatments (Surface treatments: chi-squared = 1.1136, df = 2, p-value = 0.573 & Sub-surface 

treatments: chi-squared = 4.8209, df = 2, p-value = 0.0897). Similarly, Wilcoxon rank sum tests revealed 

that no significant difference between medians could be detected within treatments (Bioballs: W= 4, 

p-value = 0.2784, Unrinsed Sargassum: W=3.5,  p-value = 0.2059, Rinsed Sargassum: no settlers).  

4. Discussion  
The amount of data collected did not suffice to answer the research question in any statistically 

significant manner. However, the observations gave reason to formulate hypothesis from the findings. 

From the Bioball treatment one can hypothesize that there is an effect of depth on settlement. Here 

only 1 post-settlement D. antillarum was observed, which must have migrated from the rope into the 

experimental unit. Higher settlement densities were found at 7 meters depth. This could have to do 

with the disturbance by waves at the surface, but a reduced abundance at the surface was not obvious 

when looking at the combined abundances of species other than D. antillarum. This hints that depth is 

likely the factor mostly affecting the observation since apart from a difference in wave action no 

variables other than depth obviously differed for the surface and submerged Bioball treatment. 

Also for the unrinsed treatment higher settler densities were found in the submerged units, but since 

in the experimental unit that had the bulk of the settlers also 17 post-settlement Diadama were found, 

the observation cannot simply be explained by depth only. Conspecifics are found to have a settlement 

inducing effect for sea urchins (Pearce & Scheibling, 1991; Dworjanyn & Pirozzi, 2008), and could have 

influenced settlement densities in these experimental units. The observation that no settlers occurred 

in the rinsed Sargassum treatment that had a maximum of 2 post-settlement D. antillarum per 

experimental unit, strengthens this idea.  

The one observation of the unit with 10 settlers that also had 17 post-settlement D. antillarum is 

basically driving the observed amount of settlers in Sargassum on its own. In other Sargassum units, 

either rinsed or unrinsed, on average more post-settlement D. antillarum were found than in the 

bioball treatment, but apart from that one observation, settler abundances did not obviously differ 

from the observed abundances of settlers in the bioballs.  

Observed amounts of post-settlers in Sargassum were highest in the unrinsed submerged Sargassum. 

Reasons for this finding could be that these D. antillarum were able to migrate over the ropes into the 

experimental units of the submerged treatments. Since the submerged ropes the experimental units 

were tied to had D. antillarum urchins on them at the beginning of the experiment, some migration 

into the experimental units on these ropes may have occurred. For the surface treatment, the ropes 

where however freshly placed and had no prior ecosystem on them. Additionally D. antillarum had to 

migrate over a relatively long distance from established ecosystems on the sub-surface ropes to the 

experimental units at the surface making migration to these units unlikely. This is reflected in the D. 

antillarum counts of the bioball treatment. There, no found D. antillarum at the surface did classify as 

post-settler D. antillarum. In the sub-surface bioball treatment 1 post-settler D. antillarum was found 

which must have migrated from the rope onto the bioballs. That migration to surface units is certainly 

happening is reflected in the occurrence of creatures other than D. antillarum in these units for the 

bioball treatment.  

While unrinsed submerged Sargassum had a relatively high amount of post-settlers in them, unrinsed 

Sargassum at the surface had at maximum two post-settlers in them. The same ratio was however not 

observed for the rinsed Sargassum were the amounts of post-settlers for the surface and submerged 

treatment did not differ obviously. If one follows this logic, the post-settlers found in the unrinsed 

Sargassum could thus be mainly urchins that remained in the Sargassum after being taken from 



drifting Sargassum patch at time of deployment. The variation found for unrinsed Sargassum is then 

an artefact of sampling from a non-uniform distribution of D. antillarum in a drifting Sargassum patch. 

However, in a 3 week pilot from June 19th till July 9th, 15  post-settlers were found in a volume similar 

to that of the current experiment filled with rinsed Sargassum. This volume also hang from an already 

present rope, and since Sargassum was rinsed these D. antillarum likely migrated from the rope into 

the Sargassum. To confidently follow any of these hypotheses more experimental evidence is 

necessary. In any way, post-settlement D. antillarum seem to be attracted to the Sargassum used in 

the experiment.  

An indication that Sargassum is in fact attracting post-settlement D. antillarum is the observation that 

there was only 1 post-settlers found in bioballs as opposed to 4 occurences where 2 post-settlement 

D. antillarum each were found in rinsed Sargassum under the assumption that rinsing got rid of already 

present D. antillarum. Alternatively, if post-settlement urchins did not migrate into the Sargassum 

from the ropes, they must have entered the drifting patch from an earlier life-stage, meaning that 

settlers are also attracted to the drifting patches. 

Furthermore, Sargassum in submerged units had degrading over the 4 week period of the experiment, 

while Sargassum in units at the surface was actually growing. This difference is not though to have had 

a major effect on the D. antillarum densities at the two depths, as abundances of post-settlers did not 

differ obviously for the rinsed treatment. However, if the experiment is to be conducted again in a 

different month, any potential effect should be mitigated.  

No D. antillarum were found in the 10 samples from the Sargassum patch used to create the 

experimental units and none were found in several smaller volumes taken around the island during 

tasks unrelated to the current experiment. From these observations, the occurrence of D. antillarum 

in Sargassum floats seems to be very coincidental. The absence of D. antillarum, but also of critters in 

general, from the 10 samples, can be explained by their migration to the cooler water in the coolbox 

before samples were put into bags. The low amount of D. antillarum in rinsed submerged Sargassum 

as opposed to their relative abundance in unrinsed submerged Sargassum at the end of the experiment 

points towards their presence in floating Sargassum rafts.  That no urchins were found in the samples 

taken during other field tasks, could have been due to their non-uniform distribution in sargassum 

floats or coincidental occurrence in certain patches.  

I must also add that the location the experiment was conducted at was already known to attract a 

relatively high abundance of settlers. This location, downstream of the main current pattern around 

the island and on the leeward side of the island, likely acts as a sink for the settlers. Extrapolating 

findings needs to be done with caution. The question whether the increased occurrence of Sargassum 

floats in the area may have an impact on settlement is then more a probabilistic than a quantifiable 

one in the sense that only every now and then a batch of larvae may end up in a patch given the right 

conditions. Follow-up research could link Sargassum float occurrence to current direction and velocity, 

and the float biomass to observed larval densities. This is however beyond the scope of the current 

project.  

Conclusion & recommendation 
To summarize, D. antillarum certainly are attracted to sargassum patches, whether as post-settler only 

or also as settler is however still unclear. Additionally, effect on settlement cannot solely be described 

to Sargassum. Only one observation had relatively high abundance of settlers, but that same 

experimental unit also had a lot of post-settlers. Cues by conspecifics could possibly play a role in 

increased settlement. In the current study no relation between predator occurrence and D. antillarum 



occurrence was obvious. A large variation in D. antillarum abundance was found for the unrinsed 

submerged treatment. Two other factors apart from cues by conspecifics could have played a role 

here. One being different rates of migration into the experimental units from existing ecosystems on 

the less recently placed ropes. The other being that this variation reflects variation of D. antillarum 

abundance in drifting Sargassum patches and so the observed variation is an artefact of the low sample 

size.  

To confidently distinguish signal from noise, some alterations to the research design need to be made. 

With a simpler , possibly unbalanced, design one can create bigger sample sizes and also introduce less 

variation per treatment. For instance by using strong fishing lines with cylindrical Sargassum- or 

bioball-filled nets attached. In such a design, surface area effect must be kept in mind however, as too 

small surfaces might not produce strong enough cues and density might not scale linearly with surface 

area. Using fishing lines instead of rope not only benefits upscaling but simultaneously tackles the 

problem of migration, since urchins cannot crawl on such narrow lines and so no migration is expected. 

This overcomes the question about cues by conspecifics, as inhibiting migration of post-settlers limits 

their abundance in the experimental units. A more thorough method however would be to only use 

rinsed Sargassum. With large enough sample sizes a possible effect of predator abundance on settlers 

can then be found by plotting the relationship between the two, which would also answer the question 

about the effect of predators irrespective of having unrinsed Sargassum as a treatment. Next to that, 

D. antillarum presence in naturally occurring drifting Sargassum patches needs to be looked into by 

sampling more patches in a standardized manner throughout the season.  

While during the current study small differences in settlement between treatments were expected 

because of lower settlement rates later in the season, the low sample sizes and 0-occurrences 

combined resulted in too little information present. This could be overcome by conducting the 

experiment earlier in the season around the peak if May/June when settlement rates are higher. With 

higher amounts of settlement, means or medians per treatment would be more separated and a more 

decisive answer could be formulated.   

Finally, while the difference in freshness of the Sargassum over the time is thought to have had no 

serious effect, it is wise that a similar experiment should minimize any potential effect the degradation 

can have by shortening the duration of the experiment.  
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Figure 1: Place lamps in a triangular fashion around object to 
photograph 

APPENDIX I 

Protocol for area measurement using (Fiji)ImageJ v2.1.0  
By Jasper Bleijenberg, July 2021 
 
First before using the program, make sure that you are using clear and sharp pictures for the analysis. 
Besides the clear and sharp pictures, it is important to standardize your setup to make sure you get 
the same light with every measurement. And there must be a ruler off some kind on the picture to 
make sure you can set the scale.  
 
Steps I took to accomplish this were: 
1.  Use a stable and flat underground 
2. Draw a boundary box on a sheet of waterresistant paper to place the leaves in. The known lengths 
of the box will function as a ruler. 
3. use 3 lights in a triangular fashion (Figure 1) to minimize shadows as these will make the automatic 
process unable to execute properly.  
4. Put camera on tripod above setup. Make sure that the whole boundary box of the sheet is in the 
frame and in focus (Figure 2).  
5. Always use manual mode to make sure that camera settings are the same.  
6. To take picture, place leaves and stalks on the paper and place sheet of glass or acrylic over them 
to press them down.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Steps in the image analysis software are:  
1. Open the opensource program ImageJ v2.1.0.  
2. Open the picture you want to analyze.  
3. Use the rectangular selection tool and select the area you want to measure from, the bounding 
box.  
3. In case of a shadow gradient over the image, cut the image in smaller pieces and analyze 
separately. Make sure to cut every image exactly the same way using the ROI (Region Of Interest) 
manager into pieces of the same area so that you can use the same scale in every image.  
4. Adjust the type of picture, so you can adjust the threshold; Image > Type > 8-Bit. This step will 
convert your picture in a greyscale picture.  
5. Now the scale has to be set. Use the straight selection tool and select a side of the bounding box. 
Now go to analyse > set scale. Now fill in its length in the box ‘Known distance’ and press OK. Note 

Figure 2: Example of image taken for analysis.  



down the amount of pixels that are given for the length inserted. With the next image you can use 
these values directly instead of using the straight selection tool first.  
6. Now make two duplicates of your selected picture by pressing ‘Ctrl + Shift + D’ twice.  
 
The first steps of this protocol were the fundament the measurement. In the next steps there is an 
explanation how to properly use the threshold. The rough edges of the leaves are sometimes hard to 
select properly, however these should be considered in the analysis.  
7. To select the area you want to measure go to Image > Adjust > Threshold. Set the top bar on ‘0’ 
and slide the lower bar to the left, stop sliding when the whole surface area of the Sargassum is red 
20 over 110 worked form me. Now press Apply to make a mask. 
8. Sometimes the darker borders get included in the process, to remove these select them and delete 
from mask. 
9. To measure the surface area of the Sargassum, go to Analyse > Analyse particles. Now make sure 
that the settings are just like in table 1. When the settings are correct press OK. Two windows should 
pop up. One with the results and one with the outlines. In the window with the outlines, you are able 
the control which numbers in the results window are the surface area of the measurement. Save the 
results and write down the surface area of the Sargassum as a back-up.  
 
Table 1: Settings of analyze particles tool 

 
 
 
 
 
 

 
10. The saved results can now be analyzed in R studio.  
 

 

  

Analyse particles settings: 

Size cm^2 → 0.005-1.00 

Show → Outlines 

Circularity → Default 

Tick: “include holes”, “display results” 



Appendix II 

Protocol collection Sargassum, deployment of experiment and processing 
By Jasper Bleijenberg, July 2021 
 
Summary  

On the day there are 3 tasks, first we prepare net bags for deployment later on. For this, a 

Sargassum patch will be visited and an amount of Sargassum enough for 26 netbags has to be put in 

the coolbox. 16 volumes (Fig. 1) are for the actual netbags and 10 volumes will be samples to 

reconstruct the composition of Sargassum species in the patch and get an idea of the creatures that 

inhabit the Sargassum. 8 volumes of Sargassum need to be rinsed and 16 bags need to be filled with 

Sargassum, 8 unrinsed and 8 rinsed samples.  

Then for the actual deployment, these 16 bags and 8 bags with bioballs that equal the same amount 

of surface area as the Sargassum ones need to be hung at the ropes at ladderbay. Four netbags per 

spot; two at the surface, and two at 7-ish meter at the ropes with the subsurface buoy, filled with the 

different treatments (Fig. 2). All netbags need to be 1 meter separated. While there, we will inspect 

the ropes to tally already present D. antillarum and possibly photograph some. 

Lastly, on shore we process the 10 samples of Sargassum by searching for creatures and divide the 

samples into species/morphologies to deduce the composition of the Sargassum patch we visited.  

 

 

 

 
 

Materials Amount 

frames 6*4=24 + some extra = 28 
Bioballs  

Waterproof data sheet + pencil (with eraser) 4  

Tie-wraps  

Tubs/bukets 10/5 
Coolbox (the big one)  

Underwater camera   

Dive computer + scuba gear + diveknife + 
datasheet with writing slate 

 1 set per diver 

Sieve  

Marked 2-gallon ziplock bags  30 

scuba tanks 6 

Mesh bag 3 

 

 

 

 

 



Preparation of bags for deployment 

Collection of Sargassum  

- Find single Sargassum patch big enough to fill 26 frames.  

- Fill the coolbox . 

Sampling  

- Fill sieve to the rim with Sargassum  (Fig. 1) 

- Put this volume in a 2-gallon Ziplock bag and store in coolbox 

- Repeat 10 times to have samples to search after deployment.  

 

Rinsing and preparing Sargassum bags 

- Put the 10 white tubs on the floor of the boat and 

fill with seawater strained with the sieve 

- Fill sieve to the rim with Sargassum  (Fig. 1) 

- Divide in 5ths and rinse each part thoroughly in a 

tub. 

- After that put all Sargassum of that round in 

bucket with fresh seawater and rinse one final 

time in the bucket. (Hopefully the extra space will 

give some organisms the intention to swim to the 

bottom.) 

- Put rinsed Sargassum in a prepared frame and 

close the frame with some tie-wraps. Also attach 

colored tie wrap to recognize that this is rinsed Sargassum. 

- Put frame in 2-galllon ziplock bags and leave  in the cooler for now  

- Refresh the bucket with seawater 

- Repeat this step a total of 8 times. 

 

 Preparing Sargassum bags without rinsing 

- Fill sieve to the rim with Sargassum   

- Put this volume of un-rinsed Sargassum in the prepared white frame and close the frame 

with some tie-wraps. 

- Put frame in 2-galllon ziplock bag and put in coolbox. 

- Repeat this step a total of 8 times 

 

 

 

 

 

Figure 1: Filing the sieve till the rim amounts for 
1 volume. So a little less than this actually 



Deployment of bags  

 

Task 

- 2 persons attach frames to the surface ropes. 

- At the same time, 2 persons gear up for 

diving and start inspecting the sub-

surface ropes for already present D. 

antillarum. They also clean the rope as 

good as possible within 5 around 

minutes per rope.When ropes are 

cleaned, they surface.  

- Now everyone gears up for diving. 3 

persons each take 2 frames from a 

treatment. 

- At the 7 m mark, the person without 

frames receives frames from one 

treatment and ties these at the rope 

with 1 meter in between the frames (Fig. 

2) 

 

! You can tie a bag at the rope by 

twisting the rope and putting the free 

tie-wrap on the bag through the cavity that this 

creates !  

 

- The result has to look like figure 4(A). 

- Swim to next subsurface buoy and repeat but for the different treatment.  

- Repeat in a second dive with the remaining 6 frames. 

 

 

The 24 bags need to be hung from 12 lines at 6 spots   

Every 3th spot has the same treatment 

Order of treatments is unrinsed – rinsed – bioballs– unrinsed – etc…  

We are with 4 people diving at location close to coral nursery (Fig. 3) 

1 extra person aboard would be helpful 

 

Figure 2: view of spot with particular treatment. 6 of these 
spots will be visited. 



 

Figure 3: Schematic top view of location of experiment. Clustered rectangles represent cinderblocks while clustered circles 
represent location where ropes were attached to unused reefball. The location is about 100 m away from the coral nursery. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4: View of frames filled with Sargassum, sub-surface (A) 
and at the surface (B). 

Rinsed 

samples 
Un‐rinsed 

samples 

Bioballs 

samples 

A B 



Processing Sargassum samples using tweaked “protocol analysis D. antillarum settlement 
collectors” 
 

 

Materials 

Samples collected in zip-lock bags 

White tubs, containers 
Analysis sheet on waterproof paper + pencil 

3 buckets: one with clean, fresh sea water, one to 
throw away the analyzed samples and one with 
fresh water. 

Pipettes 

Sticks/skewers for sorting 

Sealed mm paper 
Camera 

Small container (e.g. old yoghurt cup) to store D. 
antillarum after analysis 
Cooler with fresh sea water 

Whiteboard  

  
 
Searching for creatures in the Sargassum 

All samples are analyzed separately and as soon as possible after collection!  
1. Start with the samples that were first collected.   
2. Try to remove all organisms from the Sargassum by shaking the sample thoroughly in 
the zip lock bag.  
3. Divide sample over 5 containers. (With fresh Sargassum, 5 containers is sufficient.) 
3. Pour the remaining water in the bag into a container. Make sure no organisms stick 
in the bag.  
4. Rinse the divided samples in the container thoroughly and put the Sargassum in the 
cooler with sea water. (This Sargassum will be identified for species composition later 
on) 
6. Place the containers on a table and let them rest for 1 minute  
7. Search the containers carefully for organisms, identify them and record them on the 
analysis sheet. Use the document “Identification of marine organism in D. antillarum 
settlement traps”.   

The following organisms must be identified:  
1. D. antillarum  
2. Other sea urchins (up to species level if possible) 
3. Crabs (Spider crab/crab other) 
4. Hermit crabs  
5. Shrimps (Mantis shrimp/shrimp other) 
6. Lobster  
7. Worms (fireworm/worm other) 
8. Other crustacea 
D. antillarum can be as small as 1 mm, so look really carefully! Also, if you find a D. 
antillarum, you can suck it up with the pipette, but be careful, because if you wait too 
long with putting it in the petri dish, the D. antillarum will adhere to the pipette.  
Living D. antillarum adhere quickly to the container, if you shake the container carefully 
you can find them easily by looking at small round, red dots that are not moving. If you 



look more carefully, you can see the (striped) spines of the D. antillarum. Collect both 
living and dead D. antillarum.  
10. We usually do not find other sea urchins, but you can always recognize D. antillarum 
because they have striped spines and are very red after settlement. They turn black 
within 2 weeks, so you can also find black D. antillarum (but these still have striped 
spines). If you find other sea urchins, make sure to record them separately and make a 
picture.  
11. If in doubt if something is a D. antillarum: use the macro function of the camera to 
enlarge it, make  a picture and send it to Alwin Hylkema (alwin.hylkema@hvhl.nl)  
12. Put all D. antillarum in a petri dish   
13. If all containers from 1 sample are examined:  

a. Make a picture of the sample ID on the analysis sheet.  
b. Put the petri dish on the sealed mm paper.  
c. Make a picture of all D. antillarum in the sample. If they are close together 
you can photograph them in groups. It is important that the photograph is 
straight from above, so move the D. antillarum away from the sides of the petri 
dish before you make the pictures. The outline of the D. antillarum and the mm 
paper should both be visible.  
d. Write down any unusual observation under “remarks” (e.g. parts of the 
sample missing etc)  

14. Throw the other organisms and the seawater back in the ocean and rinse the 
containers so there are no (small) organisms left behind.  
15. Repeat the procedure for the next sample.  

 
 
Division into species for composition of patch 

16.  Fill 3 buckets with fresh sea water. 
17.  Divide the Sargassum into one of the buckets based on species/morphotype (Fig. 5). 

Figure 5: Characteristics and appearances of possible morphotypes in the samples (Govindarajan et al., 2019) 
Characteristics will be written on a whiteboard for extra clarity.  



18.  Per bucket, measure length of stalks and tally on the “Sargassum stalk length tally” 
sheet, everything under 3 cm belongs to primary stalk. Stalks longer than that count as 
individual side stalks and should be measured as such (Fig. 6). If ends of stalks have tiny 
sprouting buts, these count as part of the stalk and not as leaf. 
 

 
Figure 6: Division into main stalks and side stalks. Side stalks are identified as stalks longer than 3 cm and should be 
measured separately. 

19.  After all samples have been searched and all stalks have been measured, the 
Sargassum can be thrown away. 

  
! Always insert your data on the same day! 

  
Data entry:  

1. Make a picture of the filled in analysis sheet (so we can always look back in the 
original data.  
2. Open the data file.  
3. Save the data file as a new version, include the date in the file name.  
4. Enter all observations in the data file and save the data file.  
5. Save the pictures:  

a. The picture of the analysis sheet should be stored in “photos and videos”, 
“photos data sheets” and “period X, month year”.  
b. The pictures of the D. antillarum should be saved in “Photos and videos”, 
“size photos”, “period X, month year”, “date”, “location”.  
c. The pictures of unknown organisms should be saved in “Photos and videos”, 
“size photos”, “period X, month year”, “unknown organisms”. Make sure to add 
the sample ID (eg TR5) to the name of the photo.   
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APPENDIX III 

Protocol analysis D. antillarum settlement Sargassum 
Adapted from “Protocol analysis D. antillarum settlement collectors” by Alwin Hylkema, May 2021  
 

 Materials:  
1. Samples collected in 2 gallon zip-lock bags  
2. 10 White tubs/ containers   
3. Analysis sheet on waterproof paper + pencil  
4. 3 buckets: one with clean, fresh sea water, one to throw away the analyzed 
samples and one extra  
5. Pipette  
6. Measuring cup  
7. Sticks/skewers for sorting  
8. Sealed mm paper  
9. Camera  
10. Small container (e.g. old yoghurt cup) to store D. antillarum after analysis  

  
Methods:  
After retrieving the Sargassum  and bioball experimental units, all samples are 
analyzed separately and possibly within 4 hour after collection!  
 
 

For bioballs: 
 
1. Start with the samples that 
were collected the earliest.   
2. Try to remove all organisms 
from the bioballs by shaking the 
sample thoroughly in the zip lock 
bag.  
3. Pour the contents of the bag 
in a container. Make sure no 
organisms stick in the bag.  
4. Put 1L of clean seawater in 
the next container and rinse the 
samples again.  
5. Repeat steps 2-4 five times in 
total, use a different container 
after every rinse, so in the end 
you have 5 containers in use.   
6. Place the containers on a table 
and let them rest for 1 minute  
7. Search the containers carefully 
for organisms, identify them and 
record them on the analysis 
sheet. Use the document 
“Identification of marine 
organism in D. antillarum 
settlement traps”.   
 

For Sargassum: 
 

1.  Start with the samples that 
were collected the earliest.   
2. Try to remove all organisms 
from the Sargassum by shaking 
the sample thoroughly in the zip 
lock bag.  
3. Pour the contents of the bag 
in a container. Make sure no 
organisms stick in the bag.  
4. Put 1L of clean seawater in 
the next container and rinse the 
samples again.  
5. Divide the contents in small 
batches over several containers, 
as many as necessary to be able 
to search through the sample, 
and rinse the Sargassum 
thoroughly before throwing the 
Sargassum away.  
6. Place the containers on a table 
and let them rest for 1 minute. 
7. Search the containers carefully 
for organisms, identify them and 
record them on the analysis 
sheet, as with the bioballs.  

 
 



 
The following organisms must be identified:  

1. D. antillarum  
2. Other sea urchins (up to species level if possible) 
3. Crabs (Spider crab/crab other) 
4. Hermit crabs  
5. Shrimps (Mantis shrimp/shrimp other) 
6. Lobster  
7. Worms (fireworm/worm other) 
8. Other crustacea 
9. D. antillarum can be as small as 1 mm, so look really carefully! Also, if you find a D. 
antillarum, you can suck it up with the pipette, but be careful, because if you wait too 
long with putting it in the petri dish, the D. antillarum will adhere to the pipette.  
9. Living D. antillarum adhere quickly to the container, if you shake the container 
carefully you can find them easily by looking at small round, red dots that are not 
moving. If you look more carefully, you can see the (striped) spines of the D. 
antillarum. Collect both living and dead D. antillarum.  
10. We usually do not find other sea urchins, but you can always recognize D. antillarum 
because they have striped spines and are very red after settlement. They turn black 
within 2 weeks, so you can also find black D. antillarum (but these still have striped 
spines). If you find other sea urchins, make sure to record them separately and make a 
picture.  
11. If in doubt if something is a D. antillarum: use the macro function of the camera to 
enlarge it, make  a picture and send it to Alwin Hylkema (alwin.hylkema@hvhl.nl)  
12. Put all D. antillarum in a petri dish   
13. If all containers from 1 sample are examined:  

a. Make a picture of the sample ID on the analysis sheet (eg TR1).  
b. Put the petri dish on the sealed mm paper.  
c. Make a picture of all D. antillarum in the sample. If they are close together 
you can photograph them in groups. It is important that the photograph is 
straight from above, so move the D. antillarum away from the sides of the petri 
dish before you make the pictures. The outline of the D. antillarum and the mm 
paper should both be visible.  
d. Write down any unusual observation under “remarks” (e.g. parts of the 
sample missing etc)  

14. Throw the other organisms and the seawater back in the ocean and rinse the 
containers so there are no (small) organisms left behind.  
15. Repeat the procedure for the next sample.  

  
Always insert your data on the same day!  
  
Data entry:  

1. Make a picture of the filled in analysis sheet (so we can always look back in the 
original data.  
2. Open the data file.  
3. Save the data file as a new version, include the date in the file name.  
4. Enter all observations in the data file and save the data file.  
5. Save the pictures:  

a. The picture of the analysis sheet should be stored in “photos and videos”, 
“photos data sheets” and “period X, month year”.  
b. The pictures of the D. antillarum should be saved in “Photos and videos”, 
“size photos”, “period X, month year”, “date”, “location”.  



c. The pictures of unknown organisms should be saved in “Photos and videos”, 
“size photos”, “period X, month year”, “unknown organisms”. Make sure to add 
the sample ID (eg TR5) to the name of the photo.   

  
Samples after analysis:  

1. Soak samples in fresh water for at least 24 hours.  
2. Dry the samples.  
3. Store the samples when dry.  

 

 

 

 

 

  



D. antillarum measurement protocol ImageJ v1.0  
Alwin Hylkema, August 2019  
 
This protocol describes the procedure to measure D. antillarum recruits with ImageJ. ImageJ is a 
freeware program, made to process and analyse images. ImageJ can be downloaded via this 
link: https://imagej.nih.gov/ij/download.html.   

1. Open ImageJ and open the picture (File -> Open (CTRL + O)).  
2. To set the desired variables go to: Analyze -> Set measurements…. Deselect all 
options and click on OK.   
3. Select the line *Straight* (5th button from the left), and measure 10 mm on the mm 
paper next to the D. antillarum. To set the scale go to: Analyze -> Set scale…. Fill ‘Known 
distance:’ 10. Click on ‘OK’.  
4. To check if the scale is set right, measure again 10 mm on the mm paper. 
Press Analyze -> Measure (Ctrl + M) and check if the measurement is between 9.80 and 
10.20. If not, set the scale again and repeat the control step.  
5. Measure the diameter of the test (the body without the spines) of the D. antillarum. 
The measurement can be made in a random direction, but should go through the middle 
of the test. After you draw the measurement, press Analyze -> Measure (CTRL + M).   

 

      
Wrong measurement, because the 
spines are included.  

Wrong measurement, this line 
does not go through the 
middle  

Correct measurement  

  
6. Insert your measurements in the datafile “D. antillarum size data”.  

 

 

https://imagej.nih.gov/ij/download.html
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